
Release Notes for HP OpenView Reporter 3.70
  
What's New in this Version
 New Features

 l Support for HTTPS communication based on BBC5. For more information, see HP OpenView Reporter Concepts
Guide.

l Support for report generation on multiple OpenView Operations (OVO) for UNIX servers. For more information, see 
HP OpenView Reporter Installations and Special Configurations Guide.

l Supports generation of Reports in HTML 3.2, HTML 4.0, PDF, Microsoft Word and Microsoft Excel formats.
l Support for Oracle 10g as the database for Reporter. For more information, see HP OpenView Reporter Installations 

and Special Configurations Guide.
l Support for SQL 2005 and SQL 2005 Express as the database for Reporter. For more information, see HP OpenView 

Reporter Installations and Special Configurations Guide.
l New reports based on metrics: GBL_BOOT_TIME, GBL_SYSTEM_UPTIME_SECONDS for system uptime are added. 

For more information, refer to section Changes to Reporting. 
  
 Changes to Installation and New Requirements

 l Before installing Reporter, if you have SQL Express 2005 or SQL server 2005 installed on your system, you must
configure the Data Source Name as Reporter to SQL Server database or to any remote database. If you have not
configured the Data Source Name as "Reporter" to the remote database server, Reporter installation cannot be 
completed and the system displays a warning message. 

  
 Changes to Database Support 

 l Support for setting up Oracle 10g, SQL Express 2005 and SQL Server 2005 as the database for Reporter
l No support for Microsoft Access and Oracle 8.1.7
l Reporter also gathers data from OV Operations 7 and 8(OVO UNIX) using an Oracle 9.2.0 or 10g database

  
 Report Definition Package Changes

 l New template to create a Report definition package for supporting report generation on multiple OpenView
Operations (OVO) for UNIX servers.

l New SRP file is added to support system uptime calculation. 
  
 Changes to Reporting

 l Supports generation of Reports in HTML 3.2, HTML 4.0, PDF, Microsoft Word and Microsoft Excel formats. However, 
the default format is HTML 4.0.

l New system uptime reports are added based on the metrics, GBL_BOOT_TIME and 
GBL_SYSTEM_UPTIME_SECONDS. This is supported only on OpenView Performance Agent 4.5 and OpenView 
Operations agents. To disable the old system uptime generation, create a DisableAgentUptime registry value of
type DWORD, under the location SOFTWARE\\Hewlett-Packard\\The Reporter\\CurrentVersion and set 
the DWORD registry value key to "1". You can generate both or use any one of them depending on your performance 
agent environment. 

 Summary of Changes
New Report Package Description Replace Package
repload_ovperformance_sysuptime.SRP Install the OV Performance Agent                None              

package to get reports on System uptime 
based on the metrics GBL_BOOT_TIME 
and GBL_SYSTEM_UPTIME SECONDS.
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Announcements
HP OpenView Reporter is copyrighted and licensed by Hewlett-Packard Development Company. Please refer to the licensing 
agreements on the installation media. 
Reporter's primary function is to generate reports as Web pages from data gathered from the OpenView Performance Agent for UNIX or 
Windows, (formerly known as MeasureWare Agent) OpenView Operations Agent, version 7 and 8 (performance sub component called 
Coda) or OpenView Operations for UNIX databases (event and service data). Reporter includes a high degree of automation and 
flexibility due to its many features, including: 

l Immediate, automatic results upon installation .Routine, automatic update of data from OpenView Performance Agents and 
OpenView Operations Agents, version 7 and 8, manual configuration of new sources is not required. Application reporting offered 
by Smart Plug-Ins (SPIs) for Oracle, Informix, Sybase, SAP R/3, Microsoft Exchange, and others. Wide variety of reports to help 
you understand and manage your computing resources. Reports are generated as Web pages, so that staff members throughout 
your organization can easily access them using a variety of Web browsers.Easy operation: Reporter runs as a background 
service, automatically gathering and updating data, which it uses to refresh the Web reports each night .Easily customizable: 
Although Reporter runs out-of-the-box, you control Reporter operations through simple drag-and-drop actions in the main window. 
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QXCR1000026317

 
QXCR1000026317: Output format of Reports should be choosable as Excel, PDF and/or RTF.  
 FIX: Now you can select reports format from the available options: Microsoft Word, Microsoft Excel,  
         PDF from Reporter GUI. 
 
QXCR1000219606: Reporter 3.6 cannot be installed on SQL-Server environment with OVOW installed.  
 FIX:There is no restriction on installation. 
 
QXCR1000229709: NewDB and repload process fail with Microsoft SQL Server 2005 database.  
 FIX:NewDb and repload are compatible with Microsoft SQL Server 2005 database. 
 
QXCR1000245447: Unable to display UpTime report assigned to a single system.  
 FIX:Now you can display uptime reports for both short and long system names. 
 
QXCR1000245886: Certain reports show bad fonts and garbage if it is too long with HTML4 format.  
 FIX:You can export in HTML 3.2 format to avoid this problem. 
 
QXCR1000283135: Blank spaces in System Uptime Report.  
 FIX:Report design is modified. 
 
QXCR1000284755: RepCrys.exe -schedule does not consider Global Settings.  
 FIX:The problem is fixed in Reporter GUI. 
 
QXCR1000285742: Scheduler: different scheduletimes for Gather, GatherCODA impacted by global schedule.  
 FIX:The problem is fixed in Reporter GUI. 
 
QXCR1000298468: CLI/API to add, update and delete customers details in reporter.  
 FIX:You can add and delete customer details using repload. 
 
QXCR1000240253: Notification not sent to OpenView Operations (OVO) for Windows if OVO for Windows 7.5                                
         and Reporter 3.6 are in different systems.  
 FIX:Notification now sent to remote OVO for Windows console after report generation. 
 
QXCR1000238315: ER-Collect IP Address in Reporter Database.  
 FIX:This problem is fixed in Reporter 3.7. 
 
QXCR1000040266: Add support for configuring multiple OVO for Unix management servers to the Reporter.  
 FIX:Document and template available with Reporter 3.7 
 
QXCR1000201310: BBC5 support required for Reporter 3.7 to work with OVO for Unix 8.x.  
 FIX:Now reporter can use secure communication with OVO 8 agents. 
 
QXCR1000247508: Discover Neutron - Cannot connect to OVO for Windows Server because the RPC server is not  
         available.  
 FIX: Problem with GUI is fixed. 
 

  
Fixes in this Release 



You can modify the reports or create your own by purchasing the inexpensive report-formatting application Crystal Reports 10.0 
Professional(TM) from Business Objects. Heterogeneous: Reporter runs on a Windows 2000 , Windows 2003 or Windows XP 
operating system and can gather data from OpenView Performance Agents and OpenView Operations Agents, version 7 and 8. It 
can also gather event and service data from an OpenView Operations for Unix management server database, which stores data
gathered from a wide variety of systems.

l Service levels for Reporter transactions available: Application Response Measurement (ARM) instrumentation is included in the 
Reporter software. If OV Performance Agent is running on the Reporter system, you can produce reports that show response 
times and other key transaction metrics for primary Reporter functions (Discover, Gather, Report Engine, and others).

 
Software Requirements

l Windows 2000 Professional with Service Pack 4 or Windows 2000 Server/Advanced Server Service Pack 2 or Window XP 
Service Pack 1 or Windows 2003 Enterprise/Data center Editions. IIS 5.0 or later Web server A Web browser for viewing the 
HTML reports or for using On Demand Reports; IE 5.0 or later, or Netscape 6.1, 6.2 or 7.2 (Netscape 6.0 is NOT supported).
(Optional) Java 2 Runtime, Plug-in 1.3 for using the Java graphs feature in On Demand Reports. The end-user may be prompted 
to download this plug-in the first time their browser invokes the Java feature. The plug-in may be pre-installed on the user system.
Virtual memory should be set to an initial size of 200MB or larger on the system running Reporter. Systems running other 
applications may require larger virtual memory settings to accommodate Reporter in addition to the other applications. (Optional) 
OpenView Performance Agent for Windows or UNIX (MeasureWare Agent) versions. (Optional) OpenView Operations for 
Windows version 7.5 or OpenView Operations Agent, version 7 and later.

l (Optional) OpenView Operations for UNIX version 7 or 8 on a HP-UX or Sun Solaris management system.

At this release, OV Operations management server is supported using HP-UX or Sun Oracle  9.2.0 or 10g. You must have 
access to the Oracle Client Software - Version 9.2.0 or 10g. The client software is available from the Oracle software 
supplier or Web site at:

http://www.oracle.com/technology/software/index

We recommend using the same version, or a newer version, of "Oracle Client Software" to connect to the Oracle 
databases.

l (Optional) Reporter database supported with this release are Oracle Oracle 9.2.0 or 10g on HP-UX or Sun Solaris. You must have 
the CD set for Oracle. Specifically, during installation, you use the two CDs titled "Oracle Client Software - for Windows " and 
either "Oracle Server for HP-UX 10.20 or 11.0" or "Oracle Server for Sun SPARC Solaris." 

 
Hardware Requirements

l Intel Pentium, 500MHz or faster processor with 512MB of memory or more are recommended. Installing on a slower system or 
one with less memory may prove unacceptably slow for most users. 

¡ For up to 1000 agents, excellent performance is achieved with 500MHz processors with 512-1024MB of memory.
¡ For larger installations, refer to the chapter 'scalability' in the HP OpenView Reporter Concepts Guide.
¡ 210 MB of disk space for product, data, and system files. 

n Slightly more space may be required during product installation, depending on the installation method. 1 GB is 
recommended as a starting point for the Reporter database. Initial estimates indicate that the database can hold 
data from 100 systems (7 days total) in less than 6MB of disk space, but this number can vary.

n For more information on scalability and disk space requirements, refer to the chapter 'Scalability' in the HP 
OpenView Reporter Concepts Guide.

l Temporary disk space during report generation may range from 50-800MB, depending on the number of systems in your Reporter 
database. 

 
Supported Platforms and Databases
Supported Platforms

l Windows 2000 Professional - SP4, Windows 2000 Server - SP4, Windows 2000 Advanced Server - SP4, Windows XP - SP2
l Windows 2003 -Enterprise/Data center Editions SP1. 

Supported Databases 
Reporter Database Operating System 
SQL Server 2000 l Windows 2000 Pro/Svr/Adv -- SP4Windows XP 

Professional -- SP2
l Windows 2003 SP1 - Enterprise/Data center 

Edition 
MSDE SP 3a l Windows 2000 Pro/Svr/Adv --SP4 Windows 2003 

-Enterprise/Data center Edition
l Windows XP Professional -- SP2
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SQL 2005/Express l Windows 2000 Pro/Svr/Adv --SP4Windows 2003 
SP1 -Enterprise/Data center Edition

l Windows XP Professional -- SP2
Oracle 9.2.0 l HP-UX 11.0 (32 bit)HP-UX 11.0 (64 bit) Solaris 

2.7, 8 (32 bit)Solaris 2.7, 8 (64 bit)
l Solaris 9 

Oracle 10g l HP-UX 11.11 (64 bit)HP-UX 11.23 (64 bit) Solaris 
2.8, 9 (32 bit)Solaris 2.8, 9 (64 bit)

l Solaris 10

 
Supported/Unsupported Platforms and Databases in Cluster 
Windows Operating 
Systems

SQL Server 2000 
Enterprise Edition Oracle(All Versions) MSDE (All Versions) Access (All Versions)

Windows Server 2003, 
Enterprise Edition Y N N N

Windows Server 2003, 
Datacenter Edition Y N N N

 
Platforms and Databases Not Supported
Platform not supported 

l Windows NT Server
l Windows NT Workstation 

Databases not supported 
Reporter Database Operating System 
Access 97 All platforms 
Access 2000 NT Workstation/Server -- SP 6A XP Professional --

SP1
SQL Server 7 All platforms
SQL Server 2000 NT Workstation/Server -- SP 6A
MSDE NT Workstation/Server -- SP 6A
Oracle 8.0.6 All platforms 
Oracle 8.1.6 All platforms 
Oracle 8.1.7 HP-UX 10.20
 
Handling Services During Installation 
This section explains how the Reporter installation handles various services while it is installing. 

l The Reporter installation will stop the Reporter Service, World Wide Web Service, IIS Admin service, and any other service that 
are dependencies of these services. These services will not be available for the duration of the installation. These services must 
be stopped to perform updates for files that these services may have locked. Special care should be taken for services that are 
dependant on these services that the installer may be unaware of. These dependent services will remain stopped until they are 
either restarted manually or by a system restart. If the installer is unable to stop or start any of these services, then the installation 
will create an error dialog that will prompt for a retry. If these services are not stopped or started, the retry continues to fail and the 
user chooses to cancel the installation, then all products installed will be rolled back in an abort state of the installation. On 
occasion the World Wide Web service may be stuck due to an in-process failure of the inetinfo.exe process. In some cases, 
sending a kill signal to the inetinfo.exe process can stop this service. (See Known Problem QXCR1000043281).

l All of these services must not be set to "disabled" for the installation to continue. If the services for IIS are disabled, the installer 
will perform an error check and warn the end-user. 

 
Installing, Upgrading and Uninstalling 
Please refer to Section 1 of the Reporter Installation and Special Configurations Guide for instructions. This section of the Release Notes 
explains changes specific to this version and things you should know before upgrading. Please also read about how the installer handles 
services during installation. Contents of this section: 

l New Installation Upgrading Reporter 3.5 to Reporter 3.7 and Upgrading Reporter 3.6 to Reporter 3.7
l Install and Uninstall with integrated products

 
New Installation 

l If you are installing Reporter for the first time, the default installation directory is C:\Program Files\HP OpenView. All of the
products that are installed later (OVPA, OVIS, OVOW, etc.) will be installed in the same directory.
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l Incompatibilities with SQL Server 2000:
¡ MSDE and SQL Server 2000 are incompatible and cannot both run on the same system. This is due to dependencies on 

different versions of Microsoft's MDAC libraries. A new installation of Reporter will install the MSDE database unless it 
detects a SQL Server 2000 (client or server) on the Reporter system. If it does not find a configured Reporter ODBC Data
Source Name (DSN), it will install a Microsoft SQL Server 2000 Desktop Edition SP3a database.

¡ If you want to set up SQL Server 2000 or SQL Server 2005 or SQL Express 2005 or Oracle 9i/10g version for your 
database, follow the instructions in the Installation and Special Configurations Guide. You must install the remote
database and configure the Reporter ODBC Data Source Name (DSN) BEFORE you begin the Reporter installation. 

l Crystal 10.0 runtime DLLs are installed.
l Installation on OpenView Operations for Windows 7.5 management server or managed node is supported.
l HP foundation components are installed to support secure communication. 

 
Upgrading Reporter 3.5 to Reporter 3.7
You can upgrade Reporter 3.7 over an existing Reporter 3.5 installation. The installer will check for an existing Reporter DSN (ODBC 
Data Source Name) or Reporter data repository of any database type. If it finds one, it will upgrade the Reporter product files and will 
update your existing database to upgrade tables and fields necessary for 3.7. It will not install MSDE.
 
Changes to the installer during an upgrade from Reporter 3.5 to 3.7
Installer prompts user to enter SA password, if Reporter DSN is configured with MSDE instance.
 
Upgrading Reporter 3.6 to Reporter 3.7
You can upgrade Reporter 3.7 over an existing Reporter 3.6 installation. The installer will check for an existing Reporter DSN (ODBC 
Data Source Name) or Reporter data repository of any database type. If it finds one, it will upgrade the Reporter product files and will 
update your existing database to upgrade tables and fields necessary for 3.7. It will not install MSDE.
 
Installing with OV Operations for Windows 7.5
 

l With a new installation of Reporter and OVO/Windows 7.5 on the management server, you may install in any order.
l When installed and running with OVO/Windows 7.5, you will see some new system groups with very long names in the Reporter 

User Interface under Discovered Systems. These are groups obtained from OVO/Windows 7.5. 
 
Install and Uninstall with Integrated Products (OV Operations for Windows 7, OV Internet Services, OVPM) on a system 
OVIS 6.0 ( or later ) OVPM 5.0 (or later) , OVO 7 (or later) and OVOW 7.5 versions can co exist with Reporter 3.7.
 
What to Look for During and After Installation 

l Automatic/Manual Service Startup: During the installation of Reporter, you are prompted to select between Automatic and 
Manual startup of Reporter Service. In most cases, you should select Automatic. This selection allows Reporter actions to start 
immediately after your installation is completed and the system has been rebooted. For more information, see the Concepts 
Guide. 

If you chose manual startup during installation, Reporter service can be manually started using the Start/Stop Reporter 
Service toolbar button in Reporter's main window, or alternatively, you can open the Microsoft Windows Control Panel,
select Services, and choose Reporter Service. You will also need to set the service to Automatic startup so it will restart 
when the system is rebooted.

l Report Package Selections: During a new Reporter installation, report configuration packages (for OV Performance Agent for 
Windows/UNIX) and OV Operations Agents, version 7 and later) are automatically installed. To generate additional reports, you 
can select other Reporter packages (such as OV Operations for UNIX 7 & 8). For more information, refer to the section Getting 
Started in the HP OpenView Reporter Concepts Guide. 

Reporter can automatically locate systems running OV Performance Agent for Windows and OpenView Operations
Agents, version 7 & 8, and produce your first reports unattended. Reporter must be configured to discover systems
running OV Performance Agents and OV Operations 7 & 8 Agents on UNIX systems.

Note: If you do not have OV Performance Agent or OV Operations Agents version 7 or 8 running in your domain, some of 
your reports may be blank.

l View what happens after installation: You can view the Reporter activities in the main window status pane. For an overview of 
Reporter, select Reporter Help from the Help menu (or click the Reporter Help toolbar button).

By selecting Show Reports, the browser window will display Reporter's cover Web page, which has links to all reports just 
generated. Each day these reports are updated with the most recently collected data. There is also a link to the On 
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Demand Reports Web. 

l You can learn more about Reporter by doing the following:
¡ Open Online Help by selecting Reporter Help from the Help menu in the main window. Online Help offers descriptions 

of Reporter components and step-by-step instructions on how to accomplish different tasks. Most step-by-step instructions 
include a Show Me button, which you can select to view an animated, narrated demonstration of the task. Open context-
sensitive Help by right-clicking any item in the Reporter hierarchy and selecting Reporter Help from the shortcut menu. 
For selected dialog boxes Help is available by clicking the Help button.

¡ Access the Concepts Guide, the Installation and Special Configurations Guide, and the Release Notes from the 
Reporter Document Set toolbar button in the Reporter GUI toolbar or from the Help menu. The Reporter Concepts 
Guide is an online manual that provides information on how Reporter works. The Installation and Special Configurations 
Guide provides information on how you can customize Reporter. To print either guide, look for them in Adobe Acrobat 
format in the Reporter Help directory.

 
How Reporter Starts
After a typical Reporter installation, Reporter starts automatically at system startup. Because Reporter runs as a service, you do not have 
to be logged on in order for it to function. If necessary, you can start and stop the Reporter service manually by selecting Reporter 
Service in the Services Control Panel. At any time you can set Reporter to automatic startup by changing the Startup Mode to Automatic. 

 
The HP OpenView Reporter Folder 
Note: You can select a different program folder during installation. 

Click Start from the Task Bar. Select Programs, HP OpenView, Reporter. You should see the following icons. 
Opens the Reporter main window.

Displays the reports through your Web browser.
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Runs the perfstat program, which displays performance programs 
running. The ReportSvc (Reporter Service) program should be 
running, as should the Reporter (Reporter User Interface) if the GUI 
is open.

 

Known Problems, Limitations and Workarounds
The following areas of Reporter are either incomplete or known to not function as expected in this release.

l Migrating from MS Access to MSDE. For this type of migration, refer to http://www.microsoft.com/ for the 
instructions and tools.

l QXCR1000043560: When a product containing an embedded reporting component is uninstalled, and the parent product does 
not remove this reporting component, the Reporter ODBC Data Source Name (DSN) and the database with all the configuration 
information is left on the system. If Reporter is installed after this, and the user does not first remove the database and DSN, the 
new install will use the old database. All the configuration information will be retained and may cause error messages, as the 
configuration may depend on files that were not reinstalled by the new version of Reporter.

Workaround: Choose one of the following options: 

l Remove the database and DSN before installation.
l Remove the report configuration data from the Reporter database using the Reporter GUI.

l QXCR1000043280: MSDE installation fails if SNMP Services are running. Check the MSDE install log file
(\data\HPOVInstall\MSDE_Install.log) for the following error:

Registering performance counters from sqlctr.ini PerfmonLoad routine returned error code 6 

Workaround: Stop both SNMP Service and SNP TRAP Service, then run the installation again.

l QXCR1000043281: Uninstall cannot stop IISAdmin service, and hangs.

Workaround: Use Windows Task Manager to kill the "inetinfo" process. Keep killing it if it keeps starting up, and do so 
until the Reporter uninstall is completed. 

l QXCR1000042661: Database Engine.msi internal error 2755 could be encountered during an installation and installation may fail.
Installation fails because the c:\winnt\installer directory does not have read or write access.

If you manually try to access the directory on the system you will get a permission denied error message. To correct the 
problem it is necessary to change permissions on the folder so that Administrators and System have full control and Users 
have read/execute. Further information about this problem can be found in Microsoft Knowledge base article, Q276198.

l R555008874, ROSmm14340: When migrating the Reporter MS Access database to SQL Server 7 or 2000, nonstandard Reporter 
tables are created without a primary key. SQL Server's migration tool does not move indexes. You need to run "NewDB -empty" 
so that the tables and indexes will be built before the data is loaded.

Workaround: There are two options to fix tables built by a Smart Plug-In (SPI), DSI feed, or other process: 

1. From the SQL Server's enterprise manager, make the ID column a primary key and give it the identity property. 
Display the tables, right-click on the table you need to fix, and choose"Design Table." 

2. Click on ID's Identity box, right-click on ID, and select Set Primary Key.

l QXCR1000043489: During the report generation phase of Reporter, reports for customer created with space in name (FIRST 
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LAST) and underscore in name (FIRST_LAST) go to same directory. Whichever customer's reports run first will have their reports 
overwritten with the wrong data. This problem also applies to group names.

l QXCR1000042378: Reports have too much vertical space under Crystal 8.5/10 & HTML 4.0. Some reports generated under
Crystal 8.5/10.0 have gaps between the sections of the report. No data is lost but nearly a full page of white space may appear in
the middle of a report. The blank spaces may correspond to the area where a page break would have taken place if the report had
been printed across multiple pages.

This is an issue with Crystal Reports exporting to HTML 4.0. The Reporter 3.7 version of the RepCrys utility provides 
different export formats. These long blank spaces do not show up if the report has been exported under HTML 3.2. Users 
who develop custom reports under Crystal Reports 10.0 Professional should design their reports with HTML 4.0 in mind.

l MSDE memory limitation: You may encounter a situation where the embedded Reporter MSDE database is using too much 
memory on your system. If you do not have enough memory to start programs or programs are being ended because of memory 
shortages MSDE may be using too much of your system's memory. 

Workaround: You should first use the Windows Task Manager to check the amount of memory being used by MSDE. If 
MSDE appears to be taking too much memory you may limit the amount of memory it consumes by using the osql utility. 
The limitation that you use is dependent on your system's configuration. The example below may be used to change the 
maximum allowed memory of the MSDE server from infinite to 100 MB. At a Command Prompt enter: osql -U sa -P 
"" -S <SYSTEMNAME>\OVOPS At the osql prompt given, execute this sequence of commands. Hit the carriage return 
key after each command.

use master
go 
RECONFIGURE WITH OVERRIDE
go 
sp_configure 'show advanced options', 1 
go
RECONFIGURE
go
sp_configure 'max server memory', 100
go 
RECONFIGURE
go
exit

Your system will need to be re-booted for these changes to take effect.

l QXCR1000041639: In some cases, Gather.exe cannot reconnect to a OV Performance Agent for UNIX system (MeasureWare 
Agent) during subsequent scheduled Reporter runs. Reporter's Data Gathering by System report displays the "status" column as 
"Time Out."

Workaround: Log on to the OV Performance Agent for UNIX system (MeasureWare Agent) and run the command: 
mwa restart server. Run the Reporter Gather.exe program again.

l If the Reporter database has been purged or moved, you will get the following error in the Reporter GUI:

Could not open Reporter Database 
Could not find file "(unknown)"
Driver's SQLSetConnectAttr failed

Workaround: Recreate the Reporter database of your choice. For instructions, see the chapter, Advanced Topics in the 
HP OpenView Reporter Concepts Guide, Recovering a Corrupted Database.

l ARM DLL deletions: Aborted installations or uninstalls of OV Performance Agent on the Reporter system may leave an 
incomplete version of the Application Response Measurement library. Symptoms that point to such a situation in Reporter would 
include failure of discovery, gather, and reporting programs (immediate termination, error code 128 in the status file). You can 
verify this problem by running these programs manually from the MS-DOS prompt. If you get a message indicating errors in 
finding the library "libarm32.dll" or "libmi.dll," you should perform this workaround:

Workaround: Install the stub (NOP) ARM library from the \<INSTALLDIR>\newconfig\ directory. This workaround 
disables the collection of ARM transaction data on the affected system. Upon successful installation of the OV 
Performance Agent, a working ARM library automatically replaces the stub library. Copy the file 
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\<INSTALLDIR>\newconfig\libarmnop.dll to your \windows\system32\ directory. Delete any file in the \windows\system32\ 
directory called libarm32.dll if present.

Rename libarmnop.dll to libarm32.dll.

l QXCR1000027352: 

Summary: TopApplications report for Last7Days only shows 6 days Symptom : "Last7Days" Specifies a range of Date 
values that includes all dates from seven days ago to today (including today). Default cycle of Reporter collects data till 
previous midnight. Due to this reason "TopApplications" report shows data for 6 days only.

Solution: Use -h option for gather.exe/ gatherCoda.exe to collect the data till last hour. 

l QXCR1000157078: 

Summary: Unable to read reporter.xml Symptom: Console is unable to display reports tree and "The xml page can not be
displayed" is seen in browser.

Solution: The xml file may contain the "&" sign from the OVOW groupings. Change the groups and remove the "&" sign 
from the group name.

l On-demand reports on cluster environment are non functional 

Summary: On-demand reports on cluster environment are non functional

Symptom: The report page is not displayed in the browser.

l Error in running discover_neutron 

Summary: Error message on the discover_neutron status pane. 

Symptom: Error message is displayed on the discover_neutron status pane.

Solution: Remove the discover_neutron program from scheduler if you are not integrating with remote OVO for 
Windows management server.

l If you uninstall Reporter 3.7 as first product from OpenView Operations (OVO) for Windows 7.5 and OpenView Internet Services 
(OVIS) 6.x systems, the foundation components are not removed from the system. This is because these foundation components 
are required by Reporter lite installed in the system. Subsequent uninstallation of OVOW 7.5 and OVIS may not uninstall
foundation components. 

Solution: Remove the foundation components manually from Control Panel > Add/Remove programs.

l QXCR1000313014

Summary: If Reporter 3.7 is installed with OpenView Performance Agent 4.5, Coda does not start automatically. 

Solution: Start CODA manually

l QXCR1000314810

Summary: Reporter 3.7 uninstallation does not restore llbserver service

opcagt -kill
opcagt -start

l QXCR1000298505: 
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Summary: HP OpenView Control Service is set to 'Manual' after Reporter 3.7 installation.

Solution: Modify the startup type with service panel.

l QXCR1000311716: 

Summary: Uninstallation of OpenView Operations (OVO) 8 is not complete, when Reporter 3.7 is installed on the same 
system. 

Solution: Remove OVO 8 from Control Panel > Add/Remove programs.

 
 
Known Problems, Limitations, and Workarounds for On Demand Reports 
 

l No "trace.Analyzer" file when tracing is enabled 

If no "trace.Analyzer" file is generated even when tracing is enabled: 

l It is possible that the On Demand Report program is not being executed. Execute it manually by executing
<installation_directory>\HPOV_IOPS\cgi-bin\Analyzer.exe.

l If the previous step succeeded, but there still is no trace.Analyzer file, then perhaps the program is not being 
executed by the Web browser. Try running a browser and executing the following URL
http://<mysystem>/HPOV_IOPS/cgi-bin/Analyzer.exe?-GETNEWFORM: where "mysystem" is the name of the 
Reporter server system. 

If this fails, the Web server may not be running on that system. Check to see that IIS Web server is running (World Wide 
Web Publishing Service is STARTED).

On Microsoft Windows 2000:

1. Click Start -> Programs -> Admin Tools -> Internet Services Manager.
2. Find your server and open it in the tree.
3. Open the Services window, scroll down and find "IIS Admin Service"
4. Start the service if not running.

l A graph is drawn and the following error message appears: "The metrics in graph were not found on this data source."

This indicates that the classes and metrics do not match those required in the graph definition. 

¡ Check the graph definition and the Reporter data source to make sure they are compatible. Make sure that the date range 
selected for the graph is for data for the previous midnight. By default, Reporter does not gather data since midnight. Make 
sure the Reporter database is present and the ODBC connection is properly configured. Make sure that Reporter has data 
in the database. The database must contain a table or view that matches the "CLASS" specified for this graph. That table 
or view must contain the referenced metrics.

¡ Make sure that at least one numeric metric is selected for a line, bar, pie, or area graph.
l The first On Demand Reports Web page returns the following error message: "Database Open error." 

If you are using a Microsoft SQL Server database, make sure that the database Security is set for "SQL Server 
Authentication" rather than "Windows Authentication." For more information, refer to the instructions in the Installation and 
Special Configurations Guide. 

l The first On Demand Reports Web page returns the following error message: "CGI Error" or "Incomplete header."

Error messages such as "The page cannot be found" and "CGI Error The specified CGI application misbehaved by not 
returning a complete set of HTTP header" can be caused by the inability to run the Analyzer.exe program. 

¡ Check to see if the file Analyzer.exe is present in the /HPOV_IOPS/cgi-bin directory. If it is not there, reinstall Reporter
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¡ Determine if the Analyzer.exe program can be run manually. Create a DOS command window (run "cmd"). Change to the 
directory where the Analyzer.exe program is installed:

cd Program Files\HP OpenView\HPOV_IOPS\cgi-bin

Ask the Analyzer for its license status: 

Analyzer.exe -license 

You should get an indication that the product is properly licensed and available for use. Ask the Analyzer for its 
configuration information: 

Analyzer.exe -info 

You should get a long list of XML describing the configuration 

¡ If Analyzer.exe can be run manually, try to run it from a Web browser. Run a Web browser. Edit the URL so that it runs 
Analyzer.exe directly: http:\\localhost\HPOV_IOPS\cgi-bin\Analyzer.exe?-license You should see an error message 
followed by the license information you saw in step 2. 

http:\\localhost\HPOV_IOPS\cgi-bin\Analyzer.exe?-info

If your browser can display XML directly (IE 5.0 or later, Netscape 6.1, etc.) you should see the XML as 
seen in step 2. On some browsers, you may have to "view source" to see the actual XML.

l If Analyzer.exe can be run manually, try to run it from a Web browser. Run a Web browser. Edit the URL so that it 
runs Analyzer.exe directly: http:\\localhost\HPOV_IOPS\cgi-bin\Analyzer.exe?-license You should see an error 
message followed by the license information you saw in step 2. 

http:\\localhost\HPOV_IOPS\cgi-bin\Analyzer.exe?-info

If your browser can display XML directly (IE 5.0 or later, Netscape 6.1, etc.) you should see the XML as 
seen in step 2. On some browsers, you may have to "view source" to see the actual XML. 

l Analyzer runs manually, but does NOT run from a Web browser. Check the system PATH variable. Examine your system's 
environment variables. Look at the system environment variable PATH. It should contain the OpenView binary directory (by 
default, this will be C:\Program Files\HP OpenView\ bin). 

Whenever the system PATH variable is changed, the system must be rebooted before system services like IIS can see 
those changes. If you have not rebooted since installing Reporter or since changing the PATH variable, you should reboot
and retest. 

Some installations can have problems when the OpenView binary directory occurs in the PATH variable after another 
directory containing similar library names. If you are still having problems, reordering the directory names so that the
OpenView binary directory is the first one in the path. Do not forget to reboot after changing the path. 

l On Demand Reports main Web page access results in browser error "UNRESOLVED HOSTNAME." This means that the 
fully Qualified Domain Name (FQDN) is not properly set on the Reporter server.

If you can view the URL in the browser to see what it was unable to find, examine the first part of the URL. It should show 
a fully qualified version of your server name (such as myserver.division.company.com). If the URL has only the short
version of the server name (myserver or something like www.myserver.com, you should check your server system 
network identification information. On Windows 2000, right-click  My Computer -->Properties -->Network 
Identification -->Properties. Make sure that the server name is correct in the Computer name field (myserver 
for example). Click More and make sure that the Primary DNS suffix is filled in properly (division.company.com for
example). On Windows XP, select Start -->Control Panel -->Network. Make sure that the server name is 
correct in the Computer name field (myserver for example). Select the Protocols tab. Highlight TCP/IP Protocol and click 
Properties. Select the DNS tab and make sure that the server name is properly entered into the Host Name field, and the 
Domain field contains the rest of the address (division.company.com for example). When you are finished you may have 
to reboot. Then reinitialize the On Demand Reports Web page. Create a DOS command window (run "cmd"). 
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Change to the directory where the Analyzer.exe program is installed: 

cd Program Files\HP OpenView\HPOV_IOPS\cgi-bin

Analyzer.exe -init 

l Java graphs are cut off. 

Sometimes, the bottom of the Java graphs may not be displayed. There may also be a wide gray band to the right of the 
display. This symptom is caused by improper versions of the Java plug-in being used. 

Workaround: Uninstall all versions of the Java Plug-in (use Add/Remove Programs from the Control Panel). Then 
manually downloaded the Java plug-in, version 1.3.1_01, from http://java.sun.com/products/plugin.

l QXCR1000043645: When using Netscape from UNIX , and trying to draw Java Graphs, you will get an error if you resize the 
before the Java applet is done loading. Wait until the graph has loaded, then resize the window. 

l QXCR1000043629: Closing a browser window containing a Java graph may cause Netscape to hang with the 1.3.1_02 Java 
plugin. Netscape users should not use the 1.3.1_02 Java plugin -- any previous version of the 1.3.0 or 1.3.1 plugin can be used 
instead. The problem can also be avoided by moving the focus out of the applet by clicking on any other window on your desktop 
and then clicking back in the applet before closing the window.

Workaround: We recommend uninstalling all versions of the Java Plug-in (use Add/Remove Programs from the 
Control Panel). Then manually downloaded the Java plug-in, version 1.3.1_01, from http://java.sun.com/products/plugin. 

l QXCR1000151680: A Java graph drawn, with multiple systems selected, displays only one of the system names in the graph title. 
The html graphs display the systems in separate graphs. The Java graphs put all the systems into one graph. The graph template 
is set up for the behavior of putting systems into separate graphs, thus displays the system name for each different graph in the
title. QXCR1000042889: There is a colored symbol on the right side of the graph that can be clicked to hide/show a metric. The 
symbol and the metric should go away when the symbol is clicked, and come back if that spot is clicked again. Sometimes the 
symbol becomes visible when it should not. 

l QXCR1000043595: If you draw a Java Graph and then change something in the properties (for example, metric color), and then 
turn Auto Refresh on, the metric color will go back to its original color when the graph refreshes. 

Workaround: Open the graph in the Design tab, make the customizations you want to see and then Save the graph 
with a new name and redraw it.

l QXCR1000043644: If you open the Property page on a rotated java graph, the rotation will be lost. Location of graph output 
files. When On Demand graphs are generated, the HTML and GIF files are written to a directory based on the parameters used
to generate the graph. All files will be located in the directory, \data\webpages\VPI_All_Customers\. You may want to periodically
clean out old files from the subdirectories under VPI_All_Customers for disk space management.

l Database open error. Specified driver could not be loaded due to system error 5 (Oracle in OraHome)(err6). This is a problem 
related to inadequate access to the Oracle driver. Please change access permissions for the Oracle driver file to include 
read/execute access for everyone. If this resolves the problem, then change it and give specific access to only the Anonymous IIS 
user(and restart IIS afterwards). If not, try changing the access for the Oracle client folder(ORAHOME).

 
Known Problems and Workarounds for existing Crystal 8.5 Templates
 
The templates of Crystal 8.5 (or earlier version), when used with Reporter 3.6, (which uses Crystal 10 binaries) may break the HTML files 
created by ‘Repcrys’ module. You may have to change the 8.5 templates based on the issues encountered. Please note that all the out-
of-the-box Crystal Reports templates that accompany Reporter 3.6 Full are properly converted and should work fine without any issues.

The following changes are applicable for users who wish to use their customized Crystal 8.5 templates with Reporter 3.7.

All the reports can be edited with Crystal Reports 8.5 with the following modifications in order to be able to support Crystal 8.5 and Crystal 
10 from the same templates. If it is required to support text fields longer than 254 characters (or 127 Japanese characters), the reports 
must be edited using Crystal 10 as there is no way to do this with Crystal Reports 8.5. But any reports that are edited using Crystal 10 will 
not work on Reporter 3.5 system.
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l Problem: Crystal 10 does not truncate fields based on the field length defined in the report template. So in the exported HTML 
files, if the data in the database is longer than the field length defined in the report template, the data will overlap with the 
neighboring field.

Solution: Modify the templates to validate all of the fields to make sure the field defined in the report template is at least
the same size as the field in the Reporter database. It might not be always possible to have the full length of the database 
fields displayed, as e.g. object or application fields with 254 characters would not leave any further space in the same line 
to display further information. If possible, the according field should be configured with the "Can Grow" option, so that the 
field automatically extends vertically. If this messes up the report design, it is possible to set the "Can Grow" option with a 
maximum number of lines =1. In this case, Crystal Reports10 truncates data again, but only for formula fields and with a 
different mechanism. So plain database field objects must be placed into a formula and it must be checked if the new 
truncation mechanism does not truncate important information. 

Sometimes the problem of overlapping can not be solved only using the "Can Grow" option  (for example, if there is a field 
with a big font size, it can overlap underlying fields despite this option). In this case the problem field can be placed into 
a separate report section.

l Problem: Exported HTML reports will not have space in the LHS (left hand side). 

Solution: Modify templates for LHS space manually by setting the margin for the report. Adding an additional 1/4 inch 
margin should solve the problem.

l Problem: The Hyperlink used to display banners is not parsed and hence becomes visible text. The ‘less-than’ and ‘greater-than’
symbols are translated to character entities, which prevent the text from being recognized as HTML. 

Solution: The solution is to use OLE object linking to get some minimal of linking of banners working with Crystal Reports 
8.5 and Crystal Reports 10. Instead of embedding the banner in the report, you have to insert an OLE Link to the banner 
graphic in the report. This requires to have a fixed location and size in the banner files and customers can only exchange 
with banners of an equal size. Also, If customers want to include their own banners in the reports, they will need to 
purchase Crystal Reports 10 and modify the reports to include their banners. As they include the banner, they can size the 
banner properly inside the report.

l Problem: Boolean or single bit flag fields in the database (such as the SYSTEMS table’s EXCLUDE column) might not migrate
correctly to Crystal Reports 10. The template seems to expect a numeric value in a selection formula that should evaluate to a
Boolean.

Solution: Bit flags cannot be used with Crystal Reports10 and Oracle. Oracle knows only the numeric data type and 
accordingly Crystal Reports10's data type checking will cause an error if true/false checks are used. Therefore such fields 
must be implemented as Integer across all databases and the reports should use "field=0" checking. Using " =0" will work 
for both Oracle (numeric field) and SQL Server (bit field).

l Problem: Crystal Queries are no longer supported with Crystal Reports10. 

Solution: The reports have to be changed to work without queries. If this is not possible (example, if a UNION must be 
used without any other leading table) you might be forced to create views in the database to cover this functionality. 

l Problem: Every run of Repcys binary creates a set of files with distinct GUIDs as filename and ‘.png’ as extension in the
directories that have the generated HTML files. The user would need only the latest set of ‘.png’ files to view the generated HTML 
files. 

Solution: Schedule ‘Repmaint –clean’ so that the unwanted ‘.png’ files can be removed. It should be scheduled well after
RepCyrs has finished generating reports.

l Problem: When Crystal 8.5 templates are exported (using Reporter 3.6) with 'Page Break' option set, the 'Navigational' links in 
them will be broken. This is because there is a difference in the name of .html files that get generated when exported using 
Crystal 8.5 and Crystal 10. 
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Solution: Reporter 3.6 uses Crystal 10 and on exporting with page break, the html files are named as default.html where
n=1,2,3..k. [Whereas, the previous version of Reporter, which uses Crystal 8.5, the generated html files used be named as 
default.htm and default.htm where n=1,2,3...k] Hence Crystal Reports 10 designer needs to be used to make the 
appropriate changes to the links in the report template. 

l Problem: Formulas with the global variables and running total fields cannot be used in charts, maps. or cross-tabs.

Solution: In Crystal 10, this is no longer possible. To solve this problem the report needs to be redesigned to work without 
the use of global variables in charts.

l Problem: Crystal Reports10 aligns but does not correctly align fields with borders. 

Solution: Remove the border from the field formatting and place an empty field with border on top of the value field. 

l Problem: Crystal Report 10 cuts the blank spaces or adds empty sections at the bottom of the 
report. 

Solution: If the last line of the exported report is not completely visible in Internet Explorer, insert a blank text field in the 
report footer section. Crystal Reports10 will export the blank section at the end of the report according to the height of the 
inserted text field. 

 
 
Out of the Box Reports
Performance Reports OV Operations UNIX Reports

 
Performance Reports (OV Performance Agent, OV Operations Agent, version 7) 

Category Report Package Report 
Name Data Sources Report Type (All, 

Group, Single System) Comment 

Performance OVPerformance 01 Top CPU Busy 
Systems MeasureWare/Coda A,G

OVPerformance 02 Top Disk Busy 
Systems MeasureWare/Coda  

OVPerformance 03
Top File System 
Utilizing 
Systems

MeasureWare/Coda A,G

OVPerformance 04 Top Network 
Busy Systems MeasureWare/Coda A,G

OVPerformance 05 Top Memory 
Busy Systems MeasureWare/Coda A,G

OVPerformance 06 System 
Resources MeasureWare/Coda S

Application OVApplication 07 Top Applications by 
CPU Used MeasureWare A,G,S

Transactions OVTransaction 10 Most Active 
Transactions MeasureWare A,G,S

OVTransaction 11

Systems 
Performing 
Each 
Transaction

MeasureWare A,G

OVTransaction 12 Transactions by 
Each System MeasureWare A,G,S

Availability OVPerformance 20 System Up Time MeasureWare/Coda A,G,S
Inventory OVPerformance 30 Discovered Systems MeasureWare/Coda A,G

OVPerformance 32
Data Classes 
and Dates of 
Coverage

MeasureWare/Coda A,G,S

Administration OVAdmin 90 Scheduled Reporter 
Activities Reporter A

OVPerformance 91 Data Gathering 
From Systems Reporter A

Page 14 of 16Reporter 3.7 Release Notes



OV/Operations 8.0 for UNIX Event and ServiceReports

OVAdmin 92
Completed 
Reporter 
Activities

Reporter A

OVAdmin 93
DLL Versions 
and 
Dependencies

Reporter A

Performance OVPerformance System 
Availability MeasureWare/Coda A,G,S

This report 
uses 
GBL_BOOT_TIME 
from CODA 
datasource
and 
GBL_SYSTEM_UPTIME_SECONDS 
metric from 
SCOPE
datasource

Category # Report Name Report Type (All, 
Group, Single System) 

Inventory 31 OVO/Unix 8.0 Systems OV Operations 7 & 8 A,G
OVO/Unix Summary 9200 OVO/Unix 8.0 MessActive OV Operations 7 & 8 A
9201 OVO/Unix 8.0 PeakHours OV Operations 7 &  8 A
9202 OVO/Unix 8.0 WorkUsers OV Operations 7 & 8 A

OVO/Unix Applications 9210 Message Trend by 
Application OV Operations 7 &  8 A

9211 Resolution Time by Application OV Operations 7 &  8 A

9212 Top Active Messages by 
Application OV Operations 7 &  8 A

OVO/Unix Messages 9220 Active Messages per 
Severity OV Operations 7 &  8 A

9221 Message Load per Operator OV Operations 7 &  8 A
9222 Message Trend by Severity OV Operations 7 &  8 A
9223 Unassigned Messages OV Operations 7 &  8 A

9224 Unassigned Messages by 
Operator OV Operations 7 &  8 A

9225 Messages with activated TT 
and ITI OV Operations 7 &  8 A

9226 Assigned Messages for 
Service OV Operations 7 &  8 A

OVO/Unix Message 
Groups 9230 Messagegroup Assignment 

per Operator OV Operations 7 &  8 A

9231 Message Trend by 
Messagegroup OV Operations  7 &  8 A

9232 Resolution Time by 
Messagegroup OV Operations 7 &  8 A

9233 Top Active Messages by 
Messagegroup OV Operations 7 &  8 A

OVO/Unix Nodes 9240 Nodes per Severity OV Operations  7 &  8 A
9241 Resolution Time by Node OV Operations  7 &  8 A
9242 Top Active Messages by Node OV Operations  7 &  8 A

9243 Assigned Nodes per Node 
Hierarchy OV Operations  7 &  8 A

OVO/Unix Node Groups 9250 Message Trend by 
Nodegroup OV Operations  7 &  8 A

9251 Node Assignments by 
Nodegroup OV Operations  7 &  8 A

9252 Nodegroup Assignment per 
Operator OV Operations  7 &  8 A

9253 Resolution Time by 
Nodegroup OV Operations  7 &  8 A

9254 Top Active Messages by 
Nodegroup OV Operations  7 &  8 A

OVO/Unix 
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Acknowledgments  

9261 Message Trend by 
Acknowledgements OV Operations 7 &  8 A

9262 Message Handling by 
Operator OV Operations  7 &  8 A

9263 Resolution Time by Severity OV Operations  7 &  8 A
9264 Resolution Time by Operator OV Operations  7 &  8 A
9265 Resolution Time Trend  

OVO/Unix Configuration 9270 Inconsistent Server MSI 
Setting OV Operations  7 &  8 A

9271 Unassigned Nodes OV Operations  7 &  8 A
9272 Unassigned Responsibilities OV Operations  7 &  8 A
9273 Unassigned Templates OV Operations  7 &  8 A
9274 Undistributed Templates OV Operations  7 &  8 A
9275 Ungrouped Templates OV Operations  7 &  8 A
9276 Managed Nodes Control State OV Operations 7 &  8 A
9277 Regrouped Message Groups OV Operations 7 &  8  
9278 Distributed Templates OV Operations 7 &  8  
9279 Templates and Conditions OV Operations 7 &  8  

9277

 

OVO/Unix 
Services

Top Active Messages by 
Service OVO 6, OV Navigator A

9278 Message Trend by Service OVO 6, OV Navigator A
9279 Service Status All Data OVO 6, OV Navigator A

9280 Service Severity for the Last 
Full Month OVO 6, OV Navigator A

9280 Service Severity for the Last 
Full Week OVO 6, OV Navigator A

9280 Service Severity for Yesterday OVO 6, OV Navigator A
9281 Service Status OV Operations 7 &  8 A

9282 Message Trend by Top 10 
Services OV Operations 7 &  8 A

9289 Top 10 Most "Shaky" Services OV Operations 7 &  8 A

9500

 

OVO/Unix 
Summarized

Messages by System and 
Application OV Operations  7 &  8 A,G,S

9501 Messages by Application and 
Severity OV Operations  7 &  8 A,G,S

9502 Operator Acknowledgments OV Operations  7 &  8 A

9260 OVO/Unix 
Pending 

Pending Messages by 
Application, font-family:
Arial'>Message Group, 
Node, Node groups, Service 
and Severity

OV Operations  7 &  8 A

Page 16 of 16Reporter 3.7 Release Notes


